In this chapter, you learn some real timesavers. If you have grown tired of defining the same three layers, along with units, grid, snap, and ltscale, for each new drawing, read on. You are about to learn how to use template drawings. With templates, you can begin each new drawing with setups you have defined and saved in previous AutoCAD sessions, or with a variety of predefined setups included in the software.

In addition, you learn to reshape the grid using the LIMITS command and to copy, move, and array objects on the screen so that you do not have to draw the same thing twice. We begin with the LIMITS command, because we want to change the limits as part of defining your first template.

**OVERVIEW**

**TASKS**

4.1 Setting Limits  
4.2 Creating a Template  
4.3 Saving a Template Drawing  
4.4 Using the MOVE Command  
4.5 Using the COPY Command  
4.6 Using the ARRAY Command—Rectangular Arrays  
4.7 Changing Plot Settings  
4.8 Review Material  
4.9 WWW Exercise 4 (Optional)  
4.10 Drawing 4-1: Pattern  
4.11 Drawing 4-2: Grill  
4.12 Drawing 4-3: Weave  
4.13 Drawing 4-4: Test Bracket  
4.14 Drawing 4-5: Floor Framing  
4.15 Drawing 4-6: Threaded Shaft
4.1 Setting Limits

**GENERAL PROCEDURE**

1. Select Drawing Limits from the Format menu.
2. Enter a lower left corner.
3. Enter an upper right corner.
4. Zoom All.

You have changed the density of the screen grid many times, but always within the same $12 \times 9$ space, which basically represents an A-size sheet of paper. Now you will learn how to change the shape by setting new limits to emulate other sheet sizes or any other space you want to represent. First, a word about model space and paper space.

**Model Space and Paper Space**

Model space is an AutoCAD concept that refers to the imaginary space in which we create and edit objects. In model space, objects are always drawn at full scale (1 screen unit = 1 unit of length in the real world). The alternative to model space is paper space, in which screen units represent units of length on a piece of paper. You encounter paper space when you begin to use AutoCAD’s layout features. A layout is like an overlay on your drawing in which you specify a sheet size and other paper-related options. Layouts also allow you to create multiple views of the same model space objects. To avoid confusion and keep your learning curve on track, however, we avoid using layouts for the time being.

In this exercise, we reshape our model space to emulate different drawing sheet sizes. This is not necessary in later practice. With AutoCAD, you can scale your drawing to fit any drawing sheet size when it comes time to plot. Model space limits should be determined by the size and shapes of objects in your drawing, not by the paper you are going to use when you plot.

**Setting Limits**

Limits can be set using the LIMITS command. We begin by opening a new drawing and changing its limits from an A-size sheet ($12 \times 9$) to a B-size sheet ($18 \times 12$).

- **Type new or select New from the File menu.**
  This brings you to the familiar Select template dialog box. At this point we continue to use the acad template. Once you have created your own template, it appears in this box along with all the others.

- **Press Enter to select the acad template.**

- **Press F7 to turn on the grid.**

  You are now ready to proceed with creating new limits. Leaving your grid where it is at the lower left of your screen gives you visual feedback about what is happening when you change limits.

- **From the Format menu, select Drawing Limits as shown in Figure 4-1.**
Part I Basic Two-Dimensional Entities

The LIMITS command works in the command area. You see this prompt:

```
Reset Model Space limits:
Specify lower left corner or [ON/OFF] <0.0000,0.0000>:
```

The on and off options control a feature called limits checking. They determine what happens when you attempt to draw outside the drawing limits. With checking off, nothing happens. With checking on, you get a message that says Attempt to draw outside limits and AutoCAD does not allow you to begin a new entity outside of limits. By default, limits checking is off.

The default value shows that the current lower left corner of the grid is at (0,0), where we leave it.

✦ Press Enter to accept the default lower left corner.

AutoCAD prompts:

```
Specify upper right corner <12.0000,9.0000>:
```

Changing these settings changes the size of your grid.

✦ Type 18,12.

Your grid is redrawn with larger limits, as shown in Figure 4-2. The usual Zoom All procedure enlarges and centers the grid on your screen.

✦ Type z to enter the ZOOM command.

✦ Type a to zoom all.

You should have an 18 × 12 grid on your screen. Move the cursor to the upper right corner to check its coordinates. This is the grid we use for your B-size template drawing.

You might want to experiment with setting limits using some of the possibilities shown in Figure 4-3, which is a table of drawing sheet sizes. It shows the two sets of standard sizes. The standard you use might be determined by your plotter.
Figure 4-2

<table>
<thead>
<tr>
<th>SHEET SIZE</th>
<th>&quot;X&quot; DIM</th>
<th>&quot;Y&quot; DIM</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>11&quot;</td>
<td>8.5&quot;</td>
</tr>
<tr>
<td></td>
<td>12&quot;</td>
<td>9&quot;</td>
</tr>
<tr>
<td>B</td>
<td>17&quot;</td>
<td>11&quot;</td>
</tr>
<tr>
<td></td>
<td>18&quot;</td>
<td>12&quot;</td>
</tr>
<tr>
<td>C</td>
<td>22&quot;</td>
<td>17&quot;</td>
</tr>
<tr>
<td></td>
<td>24&quot;</td>
<td>18&quot;</td>
</tr>
<tr>
<td>D</td>
<td>34&quot;</td>
<td>22&quot;</td>
</tr>
<tr>
<td></td>
<td>36&quot;</td>
<td>24&quot;</td>
</tr>
<tr>
<td>E</td>
<td>44&quot;</td>
<td>34&quot;</td>
</tr>
<tr>
<td></td>
<td>48&quot;</td>
<td>36&quot;</td>
</tr>
</tbody>
</table>

SELECT FROM CHART
UPPER RIGHT CORNER

"Y" DIM

"X" DIM

LOWER LEFT CORNER
SETTING STAYS AT 0,0

*ANSI Y14.1 STANDARD

Figure 4-3
Some plotters that plot on C-size paper, for example, take a $24 \times 18$ sheet but do not take a $22 \times 17$ sheet. This information should be programmed into your plotter driver software and appears in the Plot Configuration dialog box in the preview image.

After you are finished exploring the LIMITS command, we will create the other new settings we want and save this drawing as your B-size template.

You are now in the drawing that we will use for your template, so it is not necessary to begin a new drawing for the next section.

### 4.2 Creating a Template

<table>
<thead>
<tr>
<th>GENERAL PROCEDURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Define layers and change settings (grid, snap, units, limits, ltscale, etc.) as desired.</td>
</tr>
<tr>
<td>2. Save the drawing as an AutoCAD Drawing Template file.</td>
</tr>
</tbody>
</table>

To make your own template so that you can begin new drawings with the settings you want, all you have to do is create a drawing that has those settings and then tell AutoCAD that this is a drawing you want to use as a template. The first part should be easy for you now, because you have been doing your own setup for each new drawing in this book.

**Make changes to the current drawing as follows:**

- GRID: 0.50 ON (F7)
- SNAP: 0.25 ON (F9)
- UNITS: 2-place decimal
- LIMITS: (0,0) (18,12)

Also, ensure that the Snap, Grid, and Model buttons on the status line are on, and that Ortho, Polar, Osnap, Otracking, and LWT are off. Dyn can be on or off.

**Load all linetypes from the acad file using the following procedure:**

1. Open the Linetype dialog box from the Format menu.
2. Click Load to open the Load dialog box.
3. Highlight the first linetype on the list.
4. Scroll down to the end of the list.
5. Hold down the Shift key as you highlight the last linetype on the list.
6. With all linetypes highlighted, click OK.
7. Click OK in the Linetype dialog box.

**Create layers and associated colors, linetypes, and settings to match those in Figure 4-4.**

Remember that you can make changes to your template at any time. The layers called text, hatch, and dim are not used until Chapters 7 and 8, in which we introduce text, hatch patterns, and dimensions to your drawings. Creating them now saves time and makes your template more complete later.

At this point, your drawing is ready to be saved as a template, which is the focus of the next task.
Chapter 4 Template Drawings

4.3 Saving a Template Drawing

**GENERAL PROCEDURE**

1. Select Save As from the File menu.
2. Enter your template drawing name in the File name edit box.
3. Select AutoCAD Drawing Template File (*.dwt) in the Files of type list box.
4. Click Save.
5. Type a template description in the Template Description box.
6. Click OK.

A drawing becomes a template when it is saved as a template. Template files are given a .dwt extension and placed in the template file folder.

- **Note:** Do not leave anything drawn on your screen or it will come up as part of the template each time you open a new drawing. For some applications, this is quite useful, but for now, we want a blank template.

- To begin this task, you should be in the drawing created in the last task. All the drawing changes should be made as described previously.
- Open the File menu and select Save As.

  This opens the familiar Save Drawing As dialog box shown in Figure 4-5. The File name edit box contains the name of the current drawing. If you have not named the drawing, it is called Drawing 1.

  Below the File name box is the Files of type box, which lists options for saving the drawing.
Open the Files of type list by clicking the arrow to the right of the list box. This opens the list of file-type options. AutoCAD Drawing Template file is fourth on the list in AutoCAD 2006.

Highlight AutoCAD Drawing Template File (*.dwt) and click it so that it shows up in the list box.

This also opens the Template file folder automatically. You see the same list of templates you have seen often using the NEW command. There are many templates there supplied by AutoCAD that might be useful to you later. At this point, it is more important to learn how to make your own.

**Note:** The templates included in the AutoCAD software consist of various standard sheet sizes, all with title blocks, borders, and predefined plot styles. These are convenient. At this point, however, they can cause confusion because they are created in paper space and automatically put you into a paper space layout. You have no need for titles and borders until we cover text in Chapter 7.

Double-click in the File name box to highlight the drawing name.

Type 1B for the new name.

**Tip:** Because template files are listed alphabetically in the file list, it might be convenient to start your template file name with a number so that it appears before the acad and Ansi standard templates that come with the AutoCAD software. Numbers precede letters in the alphanumeric sequence, so your numbered template file appears at the top of the list and saves you the trouble of scrolling down to find it.
Once your drawing name (1B) is in the name box and the Files of type box shows AutoCAD Drawing Template File, you are ready to save.

- Click Save.
  This opens a Template Description box, as illustrated in Figure 4-6. This description is used if you select the template in the Create New Drawing dialog box. You can ignore it for now.
- Click OK in the Template Description box.
  The task of creating the drawing template is now complete. All that remains is to create a new drawing using the template to see how it works.
- Open the File menu and select Close to close Drawing 1B.
- Open the File menu and select New, or pick the New tool from the Standard toolbar.
  This opens the Select template dialog box as usual. However, now 1B is at the top of your list.
- Highlight 1B on the list of Templates.

**Note:** If 1B is not at the top of your list after the PTW Templates and Sheet Sets folders, it may be because your list is sorting in descending order. To reverse order, click on Name.

- Press Enter or click Open.
  A new drawing opens with all the settings from 1B already in place.

### 4.4 Using the MOVE Command

**GENERAL PROCEDURE**

1. Type m, select the Move tool from the Modify toolbar, or select Move from the Modify menu.
2. Define a selection set. (If noun/verb selection is enabled, you can reverse Steps 1 and 2.)
3. Choose the base point of a displacement vector.
4. Choose a second point.
The ability to copy and move objects on the screen is one of the great advantages of working on a CAD system. It can be said that CAD is to drafting as word processing is to typing. Nowhere is this analogy more appropriate than in the cut-and-paste capacities that the COPY and MOVE commands give you.

- Draw a circle with a radius of 1 near the center of the screen (9,6) as shown in Figure 4-7.

As discussed in Chapter 2, AutoCAD allows you to pick objects before or after entering an edit command. In this exercise, we use MOVE both ways, beginning with the verb/noun method. We use the circle you have just been drawing, but be aware that the selection set could include as many entities as you like and a group of entities can be selected with a window or crossing box.

- Type m, select Move from the Modify menu, or select the Move tool from the Modify toolbar, as shown in Figure 4-8.

You are prompted to select objects to move.

- Point to the circle.

As with the ERASE command, your circle becomes dotted.

In the command area, AutoCAD tells you how many objects have been selected and prompts you to select more. When you are through selecting objects, you need to press Enter or right-click to move on.

- Right-click to end object selection.

AutoCAD prompts

`Specify base point or displacement:`

![Figure 4-7](image1)

**Figure 4-7**

The ability to copy and move objects on the screen is one of the great advantages of working on a CAD system. It can be said that CAD is to drafting as word processing is to typing. Nowhere is this analogy more appropriate than in the cut-and-paste capacities that the COPY and MOVE commands give you.

- Draw a circle with a radius of 1 near the center of the screen (9,6) as shown in Figure 4-7.

As discussed in Chapter 2, AutoCAD allows you to pick objects before or after entering an edit command. In this exercise, we use MOVE both ways, beginning with the verb/noun method. We use the circle you have just been drawing, but be aware that the selection set could include as many entities as you like and a group of entities can be selected with a window or crossing box.

- Type m, select Move from the Modify menu, or select the Move tool from the Modify toolbar, as shown in Figure 4-8.

You are prompted to select objects to move.

- Point to the circle.

As with the ERASE command, your circle becomes dotted.

In the command area, AutoCAD tells you how many objects have been selected and prompts you to select more. When you are through selecting objects, you need to press Enter or right-click to move on.

- Right-click to end object selection.

AutoCAD prompts

`Specify base point or displacement:`

![Figure 4-8](image2)

**Figure 4-8**
Most often you show the movement by defining a vector that gives the distance and direction in which you want the object to be moved. To define movement with a vector, all AutoCAD needs is a distance and direction. Therefore, the base point does not have to be on or near the object you are moving. Any point will do, as long as you can use it to show how you want your objects moved. This might seem strange at first, but it will soon become natural. Of course, you can choose a point on the object if you wish. With a circle, the center point might be convenient.

- Point to any location not too close to the right edge of the screen.
  AutoCAD gives you a rubber band from the point you have indicated and asks for a second point:

  Specify second point of displacement or
  <use first point as displacement>:

  As soon as you begin to move the cursor, AutoCAD also gives you a circle to drag so you can see the effect of the movement you are indicating. An example of how this might look is shown in Figure 4-9. Let’s say you want to move the circle 3.00 to the right. Watch the coordinate display and stretch the rubber band out until the display reads 3.00<0,0. (Press F6 to get polar coordinates.)

- Pick a point 3.00 to the right of your base point.
  The rubber band and your original circle disappear, leaving you with a circle in the new location.
  Now, if Ortho is on, turn it off (press F8) and try a diagonal move.

- Type m, select the Move tool, or press the spacebar to repeat the command.
  AutoCAD follows with the Select objects: prompt.

- Reselect the circle.
- Right-click to end the object selection process.
- Select a base point.
Move the circle diagonally in any direction you like.

Figure 4-10 is an example of how this might look.

Try moving the circle back to the center of the screen.

It might help to choose the center point of the circle as a base point this time and choose a point at or near the center of the grid for your second point.

Moving with Grips

You can use grips to perform numerous editing procedures without ever entering a command. This is probably the simplest of all editing methods, called *autoediting*. It does have some limitations, however. In particular, you can only select by pointing, windowing, or crossing.

Point to the circle.

The circle is highlighted and grips appear.

Notice that grips for a circle are placed at quadrants and at the center. In more involved editing procedures, the choice of which grip or grips to use for editing is significant. In this exercise, you will do fine with any of the grips.

*Note:* To remove grips and exit the grip edit mode without editing, press Esc.

Move the pick box slowly over one of the grips.

If you do this carefully, you notice that the pick box locks onto the grip as it moves over it. You can see this more clearly if snap is off (press F9). When the cursor locks on the grip, the grip turns green and the number 1.00 appears, indicating the diameter of the circle.

When the pick box is locked on a grip, press the pick button.

The selected grip becomes filled and changes colors again (from green to red). In the command area, you see

** STRETCH **

Specify stretch point or [Base point/Copy/Undo/eXit]:

![Figure 4-10](image-url)
Stretching is the first of a series of five autoediting modes that you can activate by selecting grips on objects. The word stretch has many meanings in AutoCAD, and they are not always what you would expect. We explore the stretch autoediting mode and the `STRETCH` command in Chapter 6. For now, we bypass stretch and use the MOVE mode.

AutoCAD has a convenient shortcut menu for use in grip editing.

- **Right-click.**
  This opens the shortcut menu shown in Figure 4-11. It contains all of the grip edit modes plus several other options.

- **Select Move on the shortcut menu.**
  The shortcut menu disappears and you are in Move mode. Move the cursor and you see a rubber band from the selected grip to the same position on a dragged circle. Notice that the prompt has changed to
  **MOVE**
  Specify move point or [Base point/Copy/Undo/eXIt]:

- **Pick a point anywhere on the screen.**
  The circle moves where you have pointed.

- **Press Esc to remove grips.**

**Moving by Typing a Displacement**

There is one more way to use the MOVE command. Instead of showing AutoCAD a distance and direction, you can type a horizontal and vertical displacement. For
example, to move the circle three units to the right and two units up, you would use the following procedure (there is no autoediting equivalent for this procedure):

1. Pick the circle.
2. Type m or select the Move tool.
3. Type 3,2 in response to the prompt for base point or displacement.
4. Press Enter in response to the prompt for a second point.

4.5 Using the COPY Command

<table>
<thead>
<tr>
<th>GENERAL PROCEDURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Copy Object tool from the Modify toolbar (not Copy to Clipboard, which is on the Standard toolbar).</td>
</tr>
<tr>
<td>2. Define a selection set. (Steps 1 and 2 can be reversed if noun/verb selection is enabled.)</td>
</tr>
<tr>
<td>3. Choose a base point.</td>
</tr>
<tr>
<td>4. Choose a second point.</td>
</tr>
<tr>
<td>5. Choose another second point or press Enter to exit the command.</td>
</tr>
</tbody>
</table>

The COPY command works much like the MOVE command. The main difference is that the original object does not disappear when the second point of the displacement vector is given and you can create multiple copies by picking additional displacement points. First, we make several copies of the circle in various positions on the screen.

- Type co, select Copy from the Modify menu, or select the Copy Object tool from the Modify toolbar, as shown in Figure 4-12.

  Notice that c is not an alias for COPY (it is the alias for CIRCLE). Also notice that there is a Copy to Clipboard tool on the Standard toolbar that initiates the COPYCLIP command. This tool has a very different function. It is used to copy objects to the Windows Clipboard and then into other applications or drawings. It has no effect on objects within your current drawing, other than to save them on the clipboard. We explore COPYCLIP in Chapter 10.

- Select the circle.
- Right-click to end the selection process.
- Pick a base point.

  As in the Move command, AutoCAD prompts for a second point.

- Pick a second point.

Figure 4-12
You will see a new copy of the circle. Notice also that the prompt to specify a second point of displacement has returned in the command area and that another new circle is shown at the end of the rubber band. AutoCAD is waiting for another vector, using the same base point as before.

- Pick another second point.

Repeat this process as many times as you wish. If you get into this, you might begin to feel like a magician pulling rings out of thin air and scattering them across the screen. When you finish you should have several copies of the circle on your screen, as shown in Figure 4-13.

- Press Enter to exit the command.

Copying with Grips

The grip editing system includes a variety of special techniques for creating multiple copies in all five modes. The function of the Copy option differs depending on the grip edit mode. For now, we use the Copy option with the Move mode, which provides a shortcut for the same kind of process you just executed with the COPY command.

Because you should have several circles on your screen now, we take the opportunity to demonstrate how you can use grips on more than one object at a time. This can be very useful if your drawing contains two or more objects that maintain the same relationship with each other at different locations in your drawing.

- Pick any two circles.

The circles you pick should be highlighted, and grips should appear on both, as illustrated in Figure 4-14.

- Pick any grip on either of the two highlighted circles.

The grip should change colors. This time we do not use the shortcut menu. In the command area, you see the grip edit prompt for the Stretch mode:

```
** STRETCH **
```

Specify stretch point or [/Base point/Copy/Undo/eXIt]:

Figure 4-13

You will see a new copy of the circle. Notice also that the prompt to specify a second point of displacement has returned in the command area and that another new circle is shown at the end of the rubber band. AutoCAD is waiting for another vector, using the same base point as before.

- Pick another second point.

Repeat this process as many times as you wish. If you get into this, you might begin to feel like a magician pulling rings out of thin air and scattering them across the screen. When you finish you should have several copies of the circle on your screen, as shown in Figure 4-13.

- Press Enter to exit the command.

Copying with Grips

The grip editing system includes a variety of special techniques for creating multiple copies in all five modes. The function of the Copy option differs depending on the grip edit mode. For now, we use the Copy option with the Move mode, which provides a shortcut for the same kind of process you just executed with the COPY command.

Because you should have several circles on your screen now, we take the opportunity to demonstrate how you can use grips on more than one object at a time. This can be very useful if your drawing contains two or more objects that maintain the same relationship with each other at different locations in your drawing.

- Pick any two circles.

The circles you pick should be highlighted, and grips should appear on both, as illustrated in Figure 4-14.

- Pick any grip on either of the two highlighted circles.

The grip should change colors. This time we do not use the shortcut menu. In the command area, you see the grip edit prompt for the Stretch mode:

```
** STRETCH **
```

Specify stretch point or [/Base point/Copy/Undo/eXIt]:

Figure 4-13

You will see a new copy of the circle. Notice also that the prompt to specify a second point of displacement has returned in the command area and that another new circle is shown at the end of the rubber band. AutoCAD is waiting for another vector, using the same base point as before.

- Pick another second point.

Repeat this process as many times as you wish. If you get into this, you might begin to feel like a magician pulling rings out of thin air and scattering them across the screen. When you finish you should have several copies of the circle on your screen, as shown in Figure 4-13.

- Press Enter to exit the command.

Copying with Grips

The grip editing system includes a variety of special techniques for creating multiple copies in all five modes. The function of the Copy option differs depending on the grip edit mode. For now, we use the Copy option with the Move mode, which provides a shortcut for the same kind of process you just executed with the COPY command.

Because you should have several circles on your screen now, we take the opportunity to demonstrate how you can use grips on more than one object at a time. This can be very useful if your drawing contains two or more objects that maintain the same relationship with each other at different locations in your drawing.

- Pick any two circles.

The circles you pick should be highlighted, and grips should appear on both, as illustrated in Figure 4-14.

- Pick any grip on either of the two highlighted circles.

The grip should change colors. This time we do not use the shortcut menu. In the command area, you see the grip edit prompt for the Stretch mode:

```
** STRETCH **
```

Specify stretch point or [/Base point/Copy/Undo/eXIt]:

Figure 4-13

You will see a new copy of the circle. Notice also that the prompt to specify a second point of displacement has returned in the command area and that another new circle is shown at the end of the rubber band. AutoCAD is waiting for another vector, using the same base point as before.

- Pick another second point.

Repeat this process as many times as you wish. If you get into this, you might begin to feel like a magician pulling rings out of thin air and scattering them across the screen. When you finish you should have several copies of the circle on your screen, as shown in Figure 4-13.

- Press Enter to exit the command.

Copying with Grips

The grip editing system includes a variety of special techniques for creating multiple copies in all five modes. The function of the Copy option differs depending on the grip edit mode. For now, we use the Copy option with the Move mode, which provides a shortcut for the same kind of process you just executed with the COPY command.

Because you should have several circles on your screen now, we take the opportunity to demonstrate how you can use grips on more than one object at a time. This can be very useful if your drawing contains two or more objects that maintain the same relationship with each other at different locations in your drawing.
Press the spacebar.
This brings you to the Move mode prompt:
** MOVE **
Specify move point or [/Base point/Copy/Undo/eXIt]:

Type c to initiate copying.
The prompt changes to
** Move (multiple)**
Specify move point or [/Base point/Copy/Undo/eXIt]:
You will find that all copying in the grip editing system is multiple copying.
Once in this mode, AutoCAD continues to create copies wherever you press
the pick button until you exit by typing x or pressing the spacebar.

Move the cursor and observe the two dragged circles.
Pick a point to create copies of the two highlighted circles, as illustrated in Figure 4-15.
Pick another point to create two more copies.

When you are through, press Enter or the spacebar to exit the grip editing system.

Press Esc to remove grips.

### 4.6 Using the ARRAY Command—Rectangular Arrays

**GENERAL PROCEDURE**

1. Select the Array tool from the Modify toolbar or Array from the Modify menu.
2. Define a selection set. (Steps 1 and 2 can be reversed if noun/verb editing is enabled.)
3. Press Enter to end selection.
4. Select Rectangular in the dialog box.
5. Enter the number of rows in the array.
6. Enter the number of columns.
7. Enter the offset distance between rows.
8. Enter the offset distance between columns.

The ARRAY command gives you a powerful alternative to simple copying. An array is the repetition of an image in matrix form. This command takes an object or group of objects and copies it a specific number of times in mathematically defined, evenly spaced locations.

There are two types of arrays. Rectangular arrays are linear and defined by rows and columns. Polar arrays are angular and based on the repetition of objects around the circumference of an arc or circle. The dots on the grid are an example of a rectangular array; the radial lines on any circular dial are an example of a polar array. Both types are common. We explore rectangular arrays in this chapter and polar arrays in the next.

In preparation for this exercise, erase all the circles from your screen. This is a good opportunity to try the Erase All option.

Type e or select the Erase tool from the Modify toolbar.

Type all.

Press Enter.

Now draw a single circle, radius 0.5, centered at the point (2,2).

Type ar, select Array from the Modify menu, or select the Array tool from the Modify toolbar, as shown in Figure 4-16.

This opens the Array dialog box shown in Figure 4-17.
Click Select objects at the top right of the dialog box.

This step is not necessary if you use noun/verb editing and select objects before entering the ARRAY command.

Point to the circle.

Right-click to end the selection process.

AutoCAD returns you to the dialog box.

Make sure that the Rectangular Array radio button is selected at the top left of the dialog box, as it should be by default.

Next, you determine the number of rows in the array.

Type 3 in the edit box next to the word Rows.

Now you determine the number of columns in the array. Remember, rows are horizontal and columns are vertical, as shown by the gray and white icons next to the words Rows and Columns. What would an array with three rows and only one column look like?

We will construct a five-column array.

Type 5 in the edit box next to the word Columns.

**Note:** Do not press Enter after you enter numbers in these edit boxes. AutoCAD interprets this as an OK and constructs an array with whatever information you have provided so far.
Chapter 4 Template Drawings

Before your array definition is complete, AutoCAD needs to know how far apart to place all these circles. There are 15 of them in this example—three rows with five circles in each row. There are three ways to specify this information. First, you can enter row and column offset values directly in the edit boxes on the left. Second, you can show two corners of a window using the large button to the right of the edit box. Using this option, the horizontal width of the window gives the space between columns and the vertical side gives the space between rows. Third, you can show either of the offset values independently using the buttons on the right. In this exercise, we use the default values in the edit boxes.

- Check to see that 1.00 is the value for Row offset. If not, change the value to 1.00.
- Check to see that 1.00 is the value for Column offset. If not, change the value to 1.00.

We have now provided all the information we need. Use the Preview button to check out the results.

- Click Preview at the lower right of the dialog box.

You should have a $3 \times 5$ array of circles as shown in Figure 4-18. You will also see a message box with three choices: Accept completes the ARRAY command, Modify takes you back to the dialog box where you can change or add information, and Cancel cancels the ARRAY command.

Notice that AutoCAD builds arrays up and to the right. This is consistent with the coordinate system, which puts positive values to the right on the horizontal $x$-axis and upward on the vertical $y$-axis. Negative values can be used to create arrays in other directions.

- Click Accept to complete the ARRAY command.

The message box disappears and the array remains in your drawing.

We use the array now on your screen as the selection set to create a larger array. We specify an array that has three rows and three columns, with 3.00 between rows and 5.00 between columns. This keeps our circles touching without overlapping.
Press Enter to repeat the ARRAY command.

Click Select Objects in the dialog box.

Using a window, select the whole array of 15 circles.

Right-click to end the selection process.

Enter 3 for the number of rows.

Enter 3 for the number of columns.

Enter 3 for the row offset.

Enter 5 for the column offset.

Click Preview.

You should have a screen full of circles, as shown in Figure 4-19.

Click Accept to complete the command.

When you are ready to move on, use the U command to undo the last two arrays.

Type u to undo the second array.

Type u again to undo the first array.

Now you should be back to your original circle centered at (2,2). Notice that the U command works nicely to undo an incorrectly drawn array quickly. Be aware, however, that for other purposes, the objects in an array are treated as separate entities, just as if you had drawn them one by one.

Try using some negative distances and a noun/verb sequence to create an array down and to the left.

First, use the MOVE command or grips to move your circle to the middle of the screen.

Select the circle.

Select the Array tool.

This opens the dialog box. Because you have already selected the circle, you do not have to select objects now.

Enter 3 for the number of rows.
Enter 3 for the number of columns.
Enter -2 for the row offset.
Enter -2 for the column offset.
Click Preview.
Your array should be built down and to the left. The -2 distance between rows causes the array to be built going down. The -2 distance between columns causes the array to be built across to the left.
Click Accept or Cancel to exit the command, or click Modify to continue experimenting.

4.7 Changing Plot Settings

In the previous chapter, you began using plot previews. In this chapter, we explore more options in the Plot dialog box. We have used no specific drawing for illustration. Now that you know how to use plot preview, you can observe the effects of changing plot parameters with any drawing you like and decide at any point whether you actually want to print the results. We remind you to look at a plot preview after making changes. Plot previewing saves you a lot of time and paper and speeds up your learning curve.

To begin this exploration, you should have a drawing or drawn objects on your screen so that you can observe the effects of various changes you make. The drawing you are in should use the 1B template so that Limits are set to 18 x 12. The circles drawn in the last task are fine for this demonstration.

Select Plot from the File pull-down menu, or the Plot tool from the Standard toolbar.

This opens the Plot dialog box.

The Printer/Plotter Panel

One of the most basic changes you can make is your selection of a plotter. Different plotters will use different sheet sizes and will have different default settings. We begin by looking into the list of plotting devices and showing you how to add a plotter to the list.

Click the arrow at the right of the Name list in the Printer/plotter panel.

The list you see depends on your system and might include printers, plotters, and any faxing devices you have, along with AutoCAD’s DWF6 ePlot, JPG, and PNG utilities, which can be used to send drawing and plotting information to the Internet.

The Add a Plotter Wizard

For a thorough exploration of AutoCAD plotting, it is important that you have at least one plotter available. If you have only a printer, you will probably be somewhat limited in the range of drawing sheets available. You might only have an A-size option, for example. For the exercises in this book, you can use the DWF6
ePlot utility to simulate a plotter, or you can use the Add a Plotter Wizard to install one of the AutoCAD standard plotter drivers, even if you actually have no such plotter on your system. To add a plotter, follow this procedure:

1. Close the Plot dialog box.
2. From the File menu, select Plotter Manager.
3. From the Plotters window, click Add a Plotter Wizard.
5. Check to see that My Computer is selected on the Add Plotter-Begin page, then click Next.
6. On the Plotter Model page, select a manufacturer and a model, then click Next.
7. Click Next on the Import PcP or Pc2 page.
8. Click Next on the Ports page.
9. Click Next on the Plotter Name page.
10. Click Finish on the Finish page.

When the wizard is done, the new plotting device is added to your list of plotting devices in the Plot Configuration dialog box.

- If you have closed the Plot dialog box to install a plotter driver, reopen it by selecting the Plot tool from the Standard toolbar. Then open the list of plotting devices again.

- From the list of plotting devices, select a plotter or the DWF6 ePlot utility to simulate a plotter.

**Paper Size**

Now that you have a plotter selected you should have a number of paper size options.

- From the Paper Size list, below the plotter name list, select a B-size drawing sheet.
  
  The exact size depends on the plotter you have selected. An ANSI B 17 × 11 sheet is a common choice.

**Drawing Orientation**

Drawing Orientation choices are found on the expanded Plot dialog box, as shown in Figure 4-20.

- If your dialog box is not already expanded, click the right arrow button (>) at the bottom right of the dialog box.

There are basically two options for drawing orientation: portrait, in which the short edge of the paper is across the bottom, and landscape, in which the long edge is across the bottom. Portrait is typical of a letter or printed sheet of text, and landscape is typical of a drawing sheet. Your plotting device has a default orientation, but you can print either way using the radio buttons. Drawing orientation obviously has a major impact on how the plotting area of the page is used, so be sure to check out the partial preview any time you switch orientations. Try the following:

- Click Preview to see how your current drawing orientation is interpreted.
Press Esc to return to the Plot dialog box.

Switch from landscape to portrait, or vice versa.

Click Preview again to see how drawing orientation changes the plot.

**Tip:** On some plotters, you have a choice of different paper orientations. You might have an 11 x 17 and a 17 x 11 option, for example. In this case, there should be a correlation between the paper you choose and the drawing orientation. If you are plotting in landscape, select the 17 x 11; in portrait, select the 11 x 17. Otherwise your paper settings will be 90 degrees off from your drawing orientation and things will get confusing.

For the following task, check to see that your drawing orientation is set to landscape.

This is the default for most plotters.

**Plot Area**

Look at the Plot area panel at the left of the Plot Settings dialog box. This is a crucial part of the dialog box that allows you to specify the portion of your drawing to be plotted. You have some familiarity with this from Chapter 2, where you plotted using a window selection. Other options include Display, Limits, and Extents. Changes here have a significant impact on the effective plotting area.
The list box on the left shows the options for plotting area. Display creates a plot using whatever is actually on the screen. If you used the ZOOM command to enlarge a portion of the drawing before entering PLOT and then selected this option, AutoCAD would plot whatever is showing in your Drawing Window. Limits, as you know, are specified using the LIMITS command. If you are using our standard B-size template and Limits is selected, the plot area will be $18 \times 12$. Extents refers to the actual drawing area in which you have drawn objects. It can be larger or smaller than the limits of the drawing.

Try switching among Limits, Extents, Display, and Window selections and use plot preview to see the results.

Whenever you make a change, also observe the changes in the boxes showing inches = drawing units. Assuming that Fit to paper is checked, you will see significant changes in these scale ratios as AutoCAD adjusts scales according to the area it is being asked to plot.

**Plot Offset**

The Plot offset panel is at the bottom middle of the Plot Settings dialog box. Plot offset determines the way the plot area is positioned on the drawing sheet. Specifically, it determines where the plot origin is placed. The default locates the origin point (0,0) at the lower left of the plotted area and determines other locations from there. If you enter a different offset specification, (2,3), for example, the origin point of the drawing area is positioned at this point instead and plot locations are determined from there. This has a dramatic effect on the placement of objects on paper.

The other option in Plot offset is to center the plot. In this case, AutoCAD positions the drawing so that the center point of the plot area coincides with the center point of the drawing sheet.

Try various plot offset combinations, including Center the plot, and use plot preview to see the results.

### 4.8 Review Material

**Questions**

1. Name at least five settings that would typically be included in a template drawing.
2. Where are template drawings stored in a standard AutoCAD file configuration? What extension is given to template file names?
3. What is the value of using a template drawing?
4. What is the main difference between the command procedure for MOVE and that for COPY?
5. What is the main limitation of grip editing?
6. What do you have to do to remove grips from an object once they are displayed?
7. How do you access the grip edit shortcut menu?
8. Explain how arrays are a special form of copying.
9. What is a rectangular array? What is a polar array?
10. Why is it important to do a plot preview after changing plot area or plot offset?

**Drawing Problems**

1. Create a C-size drawing template using an ANSI standard sheet size, layers, and other settings as shown in this chapter. Start with your 1B template settings to make this process easier.
2. Open a drawing with your new C-size template and draw a circle with a two-unit radius centered at (11,8).
3. Using grips, make four copies of the circle, centered at (15,8), (11,12), (7,8), and (11,4).
4. Switch to Layer 2 and draw a $\frac{1}{2} \times 1$ square with lower left corner at (1,1).
5. Create a rectangular array of the square with 14 rows and 20 columns, one unit between rows, and one unit between columns.

**4.9 WWW Exercise 4 (Optional)**

At Chapter 4 of our companion website, you will find a drawing project to complete in addition to the self-scoring chapter test. The drawing project challenges you to use edit commands in place of drawing commands. When you are ready, complete the following steps:

- Make sure that you are connected to your Internet service provider.
- Type browser or open the Web toolbar and select the Browse the Web tool.
- If necessary, navigate to our companion website at www.prenhall.com/dixriley.
  Good luck!
4.10 Drawing 4-1: Pattern

All the drawings in this chapter use your 1B template. Do not expect, however, that you never need to change settings. Layers stay the same throughout this book, but limits change from time to time, and grid and snap change frequently.

This drawing gives you practice using the COPY command. There are numerous ways in which the drawing can be done. The key is to try to take advantage of the repetition in the pattern by copying in an efficient manner. The following figures suggest one way to accomplish this:

**Drawing Suggestions**

GRID = 0.5  
SNAP = 0.25

- Begin with a 6 × 6 square. Then draw the first set of lines as in Reference 4-1a.
- Copy the first set down 0.5 to produce Reference 4-1b.
- Draw the first set of V-shaped lines. Then use a multiple copy to produce Reference 4-1c.
- Finally, make a single copy of all the lines you have so far, using a window or crossing box for selection. (Be careful not to select the outside lines.) Watch the displacement carefully and you will produce Reference 4-1d, the completed drawing.
CHAPTER 4 Template Drawings

PATTERN

Drawing 4-1
4.11 Drawing 4-2: Grill

This drawing should go very quickly if you use the ARRAY command.

**Drawing Suggestions**

GRID = 0.5  
SNAP = 0.25

- Begin with a 4.75 × 4.75 square.
- Move in 0.25 all around to create the inside square.
- Draw the rectangle in the lower left corner first; then use the ARRAY command to create the rest.
- Also remember that you can undo a misplaced array using the U command.
GRILL

Drawing 4-2
4.12 Drawing 4-3: Weave

As you do this drawing, watch AutoCAD work for you and think about how long it would take to do this by hand! The finished drawing looks like Reference 4-3. For clarity, the drawing shows only one cell of the array and its dimensions.

![Weave Drawing]

**Drawing Suggestions**

- **GRID** = 0.5
- **SNAP** = 0.125

- Draw the $6 \times 6$ square; then zoom in on the lower left using a window. This is the area shown in the lower left of the dimensioned drawing.

- Observe the dimensions and draw the line patterns for the lower left corner of the weave. You could use the COPY command in several places if you’d like, but the time gained will be minimal. Don’t worry if you have to fuss with this a little to get it correct; once you have it right, the rest will be easy.

- Use **ARRAY** to repeat the lower left cell in an $8 \times 8$ matrix.

  If you get it wrong, use **U** and try again.
WEAVE
Drawing 4-3
Part I  Basic Two-Dimensional Entities

4.13 Drawing 4-4: Test Bracket

This is a great drawing for practicing much of what you have learned up to this point. Notice the suggested snap, grid, ltscale, and limit settings and use the ARRAY command to draw the 25 circles on the front view.

Drawing Suggestions

GRID = 0.25  SNAP = 0.125  
LTSCALE = 0.50  LIMITS = (0,0)(24,18)

- Be careful to draw all lines on the correct layers, according to their linetypes.
- Draw center lines through circles before copying or arraying them; otherwise you will have to go back and draw them on each individual circle or repeat the array process.
- A multiple copy works nicely for the four 0.50-diameter holes. A rectangular array is definitely desirable for the 25 0.75-diameter holes.

Creating Center Marks with the Dimcen System Variable

There is a simple way to create the center marks and center lines shown on all the circles in this drawing. It involves changing the value of a dimension variable called dimcen (for dimension center). Dimensioning and dimension variables are discussed in Chapter 8, but if you would like to jump ahead, the following procedure works nicely in this drawing:

1. Type dimcen. The default setting for dimcen is 0.09, which causes AutoCAD to draw a simple cross as a center mark. Changing it to .09 tells AutoCAD to draw a cross that reaches across the circle.
2. Type .09.
3. After drawing your first circle, and before arraying it, type dim. This puts you in the DIMENSION command.
4. Type cen, indicating that you want to draw a center mark. This is a very simple dimension feature.
5. Point to the circle.
6. Press Esc to quit the DIM command.
TEST BRACKET

Drawing 4-4
4.14 Drawing 4-5: Floor Framing

This architectural drawing requires changes in many features of your drawing setup. Pay close attention to the suggested settings.

Drawing Suggestions

- **UNITS** = Architectural, Precision = 0’ - 0"
- **LIMITS** = 36’, 24”
- **GRID** = 1’
- **SNAP** = 2’
- **LTSCALE** = 12

- Be sure to use foot (’) and inch (”) symbols when setting limits, grid, and snap (but not ltscale).
- Begin by drawing the 20’ x 17” - 10 rectangle, with the lower left corner somewhere in the neighborhood of (4’, 4”).
- Complete the left and right 2 x 10 joists by copying the vertical 17” - 10” lines 2” in from each side.
- Draw a 19” - 8” horizontal line 2” up from the bottom and copy it 2” higher to complete the double joists.
- Array the inner 12 x 10 in a 14-row by 1-column array, with 16” between rows.
- Set to Layer 2 and draw the three 17” - 4” hidden lines down the center.
FLOOR FRAMING

Drawing 4-5
4.15 Drawing 4-6: Threaded Shaft

The finished drawing should be the top and front views without dimensions, as shown in the reference drawing. Draw the circular view first. This is the top view. Use the top view to line up the front view.

This drawing includes a typical application of rectangular ARRAY and COPY commands.

Drawing Suggestions

- Draw the circles in the top view and use these to line up the horizontal lines in the front view.
- Pay particular attention to the detail drawing when designing the acme screw thread. Draw the outline of the zig-zag shape on each side for one thread and then connect the lines, creating the full thread. Be sure the zig-zag on opposite sides is offset by one thread before drawing the angular lines.
- Now that one thread is created, a simple array completes the whole shaft length.
- Complete the drawing by adding shaft lines and the square shape at the top end.

GRID = 1/4
SNAP = 1/8
LIMITS = (0,0)(18,12)
LTSCALE = 0.5
Chapter 4 Template Drawings

THREADED SHAFT
Drawing 4-6